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Refresher Part 2: Databases  
Information Skills Practical Workshop 

 

 
 
In this workshop you will have time to identify databases relevant to your Masters dissertation and carry out 
some initial searches in these. The intention is that you find relevant academic material to support your 
research topic. 
 
Specific guidance on individual databases is provided in separate worksheets. This worksheet provides an 
overview of the workshop content and specifically covers a number of useful features you will need to be 
aware of if you intend using RefWorks software to manage the references you find and to format your 
document. 
 
Setting up an account in RefWorks was covered in Refresher Part 1: Essential Skills and is not repeated 
here. See also ‘RefWorks 2.0 – a Quick Guide’ at 
http://www.abdn.ac.uk/library/documents/guides/rfw/qgrfw002.pdf 
 

 

This workshop covers the following: 

1.     Identify databases using Primo > Advanced Search > Find Databases  Page 1 

2.     Searching Scopus Page 2 

3.     Searching other relevant databases  Page 2 

4.     RefWorks: create folders to organise references Page 3 

5.     RefWorks: Attaching files to a record in RefWorks Page 3 

6.     RefWorks: Good housekeeping – remove duplicate records Page 4 

7.     RefWorks: Create a standalone/simple reference list Page 4 

8.     RefWorksOther ways of moving records into RefWorks e.g. manual input and from 
Primo 

Page 5 

9.     Help and advice Page 5 

10.   Appendix 1: Have you checked all your sources? Page 6 

 
 

1: identify databases using Primo  
 

If you need to find scholarly and academic research papers to support your dissertation topic (you’ll be doing 
a very strange research topic if this is not the case!) you will need to identify the most appropriate databases 
to use for your research topic. There is no one perfect database as material is listed in a wide range of 
different databases, with overlap and unique material in each source.  
 

By using Primo you will be able to identify databases that you will need to search as part of your literature 
review process. 

1. Go to http://primo.abdn.ac.uk:1701/ and log in using your University computer username and 
password 

 

2. Click on the Advanced Search link located beside the Simple Search button 

3. Click on the Find Databases link to the right of the search boxes. The Find Databases window will now 
open 

4. Using the Category drop-down menu select the general subject area for your subject interest 

5. Using the Sub-category drop-down menu select a more specific subject area of interest 

6. Click on the Find databases button 

7. An A-Z list of databases relevant to your subject is displayed 

http://www.abdn.ac.uk/library/documents/guides/rfw/qgrfw002.pdf
http://primo.abdn.ac.uk:1701/
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8. Click on the Show Info link beside a database to find out what it covers and the search rules you must 
use 

9. Write down the names of up to five databases that may be relevant to your dissertation research topic. 

 

10. Relevant databases 

 

 

 

 

 

 

 

11. You will have a little time later in the workshop to search some of these databases. At that time you will 
click on the title of a database to link out and search it 

 
 

2: Search Scopus (for journal articles and conference papers)  
 
It is often a good strategy to start your search for journal articles and conference papers in either of the two 
largest databases – Scopus or Web of Science. 
 

Scopus database 

1. Go to http://www.scopus.com 

2. Click on Add search field to give you two search boxes 

3. In the first box enter the keywords for your first idea from your planning sheet 

4. In the second box enter the keywords for your second idea from your planning sheet 

5. Click on the Search button 

6. How many hits do you get? __________________ 

7. When you are looking for a topic for the first time you may find it useful, after you have carried out the 
first keyword search, to limit your search to Document Type = Review. A review article in your 
subject area that has been published in the last few years can be very useful in pulling together a 
wide number of source papers in the topic area. 

a)   In the left hand column look for Document Type and refine your search by this option 

b)   How many review articles do you have? ___________________ 

8. Try out other search and limits options within Scopus and sort your results in different ways e.g. by 
Relevance, by Citations. A more detailed worksheet for this database is available – collect one as 
part of the workshop 

9. Once you are in the position of having selected relevant references, refer to the Import Methods 
handout with this workshop and move the records to your RefWorks account. You can file these 
records in an appropriate folder within RefWorks – see section 4 of this worksheet for details. 

10. If you find relevant papers in full text save these to your H drive for later use.  

.  
 

3: Use other relevant databases (for journal articles and conference papers)  
 

A literature review requires you to access a number of different sources to look for relevant research in your 
area. It is rare that you would find everything you need in one database as they all cover different journals 
and different timespans. 
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1. Collect worksheets for relevant databases as you have previously identified in section 1 (page 2) of this 

worksheet. 
 

2. Try searching in one of these databases. You can save full text items on your H drive and export 
relevant references to your RefWorks account - refer to the Import Methods handout with this 
workshop for instructions. You can file these records in an appropriate folder within RefWorks – see 
section 4 of this worksheet for details. 

 
3. You will be able to continue your searches outside the workshop. 

 

RefWorks: for future reference export/import instructions for many Aberdeen University databases are 
available online at http://www.abdn.ac.uk/~wdl010/documents/guides/rfw/importing.pdf 

 

4: RefWorks: Create folders to organise references  
 

It is a good idea to organise your references in folders to make it easier to keep track of references needed for 
particular pieces of work. A reference is always held in your personal database until you delete it – once a 
record is deleted the RefWorks ID number associated with it is deleted and is never re-used. A reference exists 
in your main database and can be filed in more than one folder or in no folder at all.  
 
This section shows you how to create folders in advance for storing references related to your dissertation 
topic. Please follow the instructions below if you have not already set up folders within your RefWorks account. 
 

1. Login to your RefWorks account 

2. Click on the New Folder button  

3. Name the folder and then click on Create. If you cannot think of names for the folders then use the 
name test1 for this exercise. 

4. Repeat to create several folders if you think they will be of use to you. 
 

 

5: RefWorks: Attaching files to a reference in your RefWorks account  
 

You can attach files to a record of a reference via your main RefWorks account. Attachments can be any 

type of computer file that you want to associate with the bibliographic information you store, e.g. the full text 

PDF of a journal article. The file(s) you attach are stored securely on RefWorks servers. 

 

In order to view or play the file attachments, you will need the appropriate software for that object type on the 

computer you are accessing the file from, e.g. Adobe Reader for PDF files. 

 

There is no limit to the number of files you can attach to your reference, but there are overall storage limits 

on a per user basis, designated by the University of Aberdeen. You will receive a message alerting you if you 

exceed either the file size limit or the limit set for your individual account – contact Susan if you require your 

file limit to be increased. 

 

A paper clip icon is clearly displayed on the record within RefWorks indicating a file attachment. 

 

Attachment file names are searchable from the Search your RefWorks database box or by searching the 

Attachment field in Advanced Search. 

To attach files to a reference:  

 
1.    The files that you attach must already be stored on your PC or on your H drive or on a memory stick. 

Attaching the file to the record in RefWorks gives you additional and convenient access to the file. It is 
our recommendation that the RefWorks attachment is an additional copy, not the only copy of the file. 

 

2.    Open/login to your main RefWorks account 

3.    Open the full record view of an existing reference by clicking on the Edit icon 

4. Scroll down to the Attachments entry in the record 

http://www.abdn.ac.uk/~wdl010/documents/guides/rfw/importing.pdf
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5.  Click the Browse button to locate the file you wish to add (only 1 file can be attached at a time), e.g. a 
full text journal article saved on your H:drive 

6. Click the Save Reference button to upload your file.  

7. Repeat for EACH file you wish to attach 

8. Close the record window when you have finished uploading the file(s) for that reference. 

 
 

6: Good housekeeping – removing duplicate records 
 
When you import records there is now a link in the import window called Duplicate Checking Options. This 
enables you to check immediately if one of the records you’re importing is already in your RefWorks account. 
Select Close Duplicates and click the View Duplicates button. 
 
You may not find duplicates today but it is good practice to run a check for duplicates regularly – preferably 
every time you import records. Removing newly imported duplicates of records you already have avoids 
potential confusion later on. 
 
Never delete records that you know you have already cited in your work – only the later duplicates. 
 
Exercise: 
 

1. In your main RefWorks account click on the View menu, then Duplicates and select Close 
Duplicates 

2. The duplicate records are displayed. RefWorks automatically selects the newest record to remove 
(higher reference ID number) because you more likely to have used the first (older) record. 

3. Click on the Edit icon to view the full details of a record. It is possible to cut and paste information from 
one record into another, e.g. cut abstract information from a newer record and paste into the older one. 

4. When you are satisfied that you are ready to delete the selected records click on the Delete button 
(red cross) at the top of the results list. 

5. A CAUTIONARY NOTE: Once the records are deleted you can retrieve them as they are held in a 
temporary folder for a number of days but it is better to get it right first time. To see your deleted 
references go to the View menu and click on Deleted References. 

 
 

7: Creating a standalone/simple bibliography (list of references)  

 

Your supervisor may ask for a list of references that you have used to date as a check on how well your 

research and literature review is progressing. RefWorks can create this type of list in a wide range of output 

styles or formats. The lists/bibliographies can be produced for your complete RefWorks database or for 

named folders (not sub-folders) within your database. 

 

In this exercise you will create a standalone bibliography from the records in a folder of your choice, or for 

your complete database provided you don’t have more than 50 records in it (we’ve set this limit only for time 

reasons as there are so many potentially carrying out the same task at the same time). 

 
Exercise: 
 

1. In RefWorks click on the Create Bibliography button 

2. Select the Output Style. For this exercise choose Harvard – British Standard from the drop-down list 

3. Make sure that the options for Format a Bibliography from a list of References are showing 

For File Type select Word for Windows (2000 or later) 

For References to Include select a folder from the drop-down list 

Click on the Create Bibliography button 
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4. RefWorks will tell you that the bibliography is complete in a small pop-up box in the bottom right-hand 
corner. Click on the first click here link in the pop-up box. 

Another box will open. Click on Save. Call the document testbib.doc and save it to your H:drive. 

You can modify or print off your testbib.doc document as required. 

5. You must always proof read the bibliography created by RefWorks as it may not always produce a 
perfect result. The software relies on the accuracy of the input from external sources (database 
suppliers, or you if the reference has been manually input!) and the ability of the RefWorks filters to 
translate the references correctly. Some errors may creep through and it is your responsibility to read 
and correct them in your main RefWorks account. 

6. The RefWorks output styles/formats work to broad international standards but there can be wide 
variation in the formatting of a named style. Your lecturer may specify Vancouver or Harvard style but 
not the exact Vancouver or Harvard style as produced by RefWorks. Check with your lecturer or 
supervisor on their requirements. 

We look at options to preview the many thousands of styles within RefWorks in Part 3 of this workshop 
series. More guidance on this is provided on the RefWorks help screens. Click on the Help menu in 
your main RefWorks account. 

 
 

8: Other ways to move records into your RefWorks account 
 
If you need to bring in records for books from Primo please refer to the Import Methods sheet for guidance. 
 
If you need to create a record for a webpage or other item that you have found from a source other than a 
database, please refer to the Import Methods sheet for guidance – instructions are provided under Manual 
records. 
 

9: Help and advice  

If you have any problems with accessing RefWorks or using any of the features, please contact the IT 
Service Desk. 
 
There are many other features available to you within RefWorks with more covered in Refresher Part 3: 
Managing your dissertation research. To find out about other specialised features: 
 
Information Consultants can also help with any subject specific difficulties: 
 

Arts & Humanities  

Janet MacKay  

j.i.mackay@abdn.ac.uk 

tel: 01224 272572 

 

Education, Music & Social Sciences  

Claire Molloy  

c.a.l.molloy@abdn.ac.uk 

tel: 01224 274813 

 

Life and Physical Sciences & Engineering  

Susan McCourt  

s.mccourt@abdn.ac.uk  

tel: 01224 273287 

 

Law & Business Studies 

Elaine Shallcross  

e.shallcross@abdn.ac.uk  

tel: 01224 273848  

 

Medicine & Biomedical Sciences  

Mel Bickerton  

m.bickerton@abdn.ac.uk  

tel: 01224 437876 

 

IT Service Desk – for access problems  

Email: servicedesk@abdn.ac.uk  

Tel.: 01224–273636 (also the ‘Out of Hours’ service number) 
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Appendix 1: Have you checked all your sources? 
 

Type of Information Coverage Source Do I need this? Completed? 

Books Established topics, background 
information/reading 

Primo   

Research theses Specialised topics Primo   

E-books Background 
information/reading, 
convenience if away from 
campus 

Primo and 
collection specific 
sites  

  

Research papers 
(journal articles) 

Academic and scholarly 
research: old/classic, trends, 
current, breaking 

Databases   

Reports Wide variety of organisations, 
governmental, professional or 
industry specific  

Search engines 
e.g. Google 

  

Commercial data Industry specific Search engines 
e.g. Google 

  

Specialised e.g. 
Patents 

Unique/novel, industry 
specific 

Specific 
databases, 
Scopus, Google  

  

 


